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1. Discovering Open eVision

Open eVision

Open eVision is a set of powerful image processing tools developed for computer vision
applications. They cover most state-of-the-art techniques in digital image processing, from
classical algorithms to advanced solutions ready-made for specific tasks.

Many of the available tools are designed to be self-consistent and easy to use. Nevertheless, for
more advanced uses, you should find everything you need to build you own workflow by
combining the numerous building blocks provided.

Open eVision is made of a set of C++ and .NET classes ready for integration in your application.
The tools are in no way a closed solution and do require to be integrated in your own
application, leaving you all the freedom to deal with all other aspects of the automation not
related to image processing.

Open eVision Libraries and Tools
□ Basic Types and Operations contains the definition of fundamental objects, types, classes

and functions used in all Open eVision components.

General Purpose Libraries

EasyImage offers gray-level image processing functions that improve image
quality and contrast between background and objects of interest as well as
linear and non-linear filtering and geometric transformations. It also offers
tools for quantifying image focus, sliding window statistics and histogram
analysis.

EasyColor contains color image processing functions that efficiently convert
images between several color systems.
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Matching and Measurement Tools

EasyObject obtains information about distinct objects (blob analysis),
identifies them using connected component labeling, then sorts and selects
them according to their geometric features.

EasyGauge assesses dimensions of objects to sub-pixel precision, detects
edges, locates points and fits geometric models. If the field of view is
calibrated, it also measures in physical units (mm, inch...) instead of pixels.

EasyFind locates patterns in an image based on a geometrical model from a
reference pattern or template. Compared to EasyMatch, it is computationally
fast, robust against noise, occlusion, blurring and illumination variations.

EasyMatch locates patterns in an image based on a pixel-by-pixel comparison
with a reference pattern or template. It can be used for image registration or
component placement inspection.

EChecker2 creates a golden template and inspects images.

Text and Code Reading Tools

● List of Supported Codes

● Code Grading

ECodeReader reads all codes in one unified interface.

EasyBarCode reads bar codes.

EasyBarCode2 reads multiple bar codes.

EasyMatrixCode and EasyMatrixCode2 read data matrix codes.

EasyQRCode detects and decodes QR codes.

EasyOCR performs optical character recognition. You can use it for reading
serial numbers or printed labels.

EasyOCR2 offers advanced and improved optical character recognition
functions.
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Deep Learning Inspection Tools

Deep Learning Tools inspects images with deep learning technology.

EasyClassify classifies images.

EasySegment, supervised or unsupervised, detects and segments images.

EasyLocate finds and identifies objects in images. The location of an object is
represented by a bounding box.

3D Processing Tools

Easy3D offers a set of tools for solving computer vision problems using 3D
acquisition and processing.

Easy3DLaserLine retrieves, extracts and calibrates the laser line in images.

Easy3DObject extracts 3D objects in images.

Easy3DMatch load a reference and a sample and to align and find the
transformation from the sample to the reference and compares an aligned
scan with a reference model or mesh.

The Studios

The Studios are software applications that allow you to test all Open eVision libraries and tool.
they speed up and automate the creation of a solution for your vision problem.

You can test the functions to find appropriate parameter values, and generate the code of your
operations to copy and paste into your own applications.

The Studios are available in the Euresys download area and do not require any license.

Open eVision Studio to evaluate and prototype your application.

Open eVision Deep Learning Studio to train and evaluate your deep learning
application.

Open eVision 3D Studio to evaluate and prototype your 3D application.
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Sample programs

During installation, Open eVision copies the following files in the public document folder
(C:\Users\Public\Documents\Euresys\Open eVision xx):

□ sample projects showing how to use Open eVision libraries with a particular IDE.
□ sample application programs showing how to combine Open eVision functions and

libraries in a variety of combinations and applications.

Open eVision Getting Started PART I Open eVision Basics
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2. Using Vision in your Application

A typical vision-based application follows these steps:

1. Prepare your setup

● To optimize resolution and repeatability, configure and adjust your test setup so that:
□ It simulates the targeted inspection equipment as accurately as possible, with a realistic

lighting environment.
□ The area of interest fills most of the field of view.
□ The properties or the defects are as visible as possible.

● Create two series of images:
□ Objects without defects, accepted by the inspection process, in all possible situations

(such as unstable lighting conditions and movement freedom).
□ Objects with unacceptable defects to be rejected by the inspection process.

2. Acquire images

Your images, coming from external sources, are stored in the PC memory buffer at a known
address.

● You need to link these to Open eVision image objects with the parameters containing the
address and pitch (32 bytes by default) of the buffer and the width and height of the image.

2 For details, see "Pixel Container Definition" on page 12 and "Memory Allocation" on page 1.

3. Pre-process your images

● Use Open eVision libraries and tools to process and optimize your images to:
□ Reduce the acquisition defects.
□ Enhance the properties such as the contrast between the object of interest and the

background.
□ Enhance the localization and tracking of objects with edge enhancement...

2 For details, see "Discovering Open eVision" on page 5.
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4. Locate objects of interest

● On your images, locate the area of interest using techniques such as segmentation, edge
detection or pattern matching.

5. Analyze your findings

On the found objects in your image:

● Perform a measurement with EasyObject orEasyGauge.

● Search and check a matching with EasyFind or EasyMatch.

● Decode and read bar codes with EasyBarCode, EasyMatrixCode or EasyQRCode.

● Find and read a text with EasyOCR.

● Perform a processing on 3D images with Easy3DLaserLine, Easy3DObject or Easy3DMatch.

6. Optimize your application

Your solution must reliably separate good images from bad images by comparing ROI features
to assess quality, detect defects or recognize, sort and decode objects. If it is not the case,
repeat steps 3 and 4 to improve your setup and your processing.

Develop thread safe applications

Open eVision supports simultaneous execution by multiple (unlimited) threads on the same
CPU, but the data can only be accessed by one thread at a time.

● Your application can execute independent tasks simultaneously, but each bit of shared data
must be controlled by a separate task.

● Follow the rules about thread-safe classes to avoid data corruption, crashes and
misbehaving programs.

2 For details, see "Multicore Processing" on page 1.

Open eVision Getting Started PART I Open eVision Basics
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Report errors

When an Open eVision function fails, it throws an exception that contains an error code and a
description.

● To catch a potential exception, include the function call in a try-catch block.

2 For details, see EException.GetError and EException.What.

Measure execution times

● Simply use the following functions to time a particular piece of code:
□ Start timing: Easy.StartTiming
□ Stop timing: Easy.StopTiming
□ Clock resolution: Easy.TrueTimingResolution

Open eVision Getting Started PART I Open eVision Basics
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3. Dealing with Pixel Containers and
Files

3.1. Pixel Container Definition

Image objects

The Open eVision image objects contain image data that represents rectangular images.

Each image object has a data buffer, accessible via a pointer, where pixel values are stored
contiguously, row by row.

Image main parameters

The rectangular array of pixels of an Open eVision image object is characterized by the EBaseROI
parameters:

● The Width is the number of pixels per row of the image.

● The Height is the number of rows of the image.

● The Size contains both the Width and the Height of the image.

The maximum size for the width and the height is:
□ 32,767 (215-1) in Open eVision 32-bit
□ 2,147,483,647 (231-1) in Open eVision 64-bit

● The Plane contains the number of color components.
□ For gray-level images: Plane = 1
□ For color images: Plane = 3
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Classes

The image and ROI classes derive from the abstract class EBaseROI and inherit all its properties.

Depth maps

A depth map represents a 3D object using a 2D grayscale image in which each pixel represents a
3D point.

□ The pixel coordinates are the X and Y coordinates of the point.
□ The gray value of the pixel is a representation of the Z coordinate of the point.

Open eVision Getting Started PART I Open eVision Basics
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Point clouds

A point cloud is an unstructured set of 3D points representing discrete positions on the surface
of an object.

The point clouds are produced by various 3D scanning techniques, such as laser triangulation,
time of flight or structured lighting.

2 For details, see, for example, en.wikipedia.org/wiki/Point_cloud.

3.2. Pixel Container Types

2 For the enumeration of the available types, see "EImageType Enum" on page 1.

Images

Open eVision supports the following image types according to their pixel types.

Open
eVision

Genicam
PNFC Definition Class

BW1 Mono1 1-bit black and white image (8 pixels are stored in 1 byte). EImageBW1
BW8 Mono8 8-bit grayscale image (each pixel is stored in 1 byte). EImageBW8
BW16 Mono16 16-bit grayscale image (each pixel is stored in 2 bytes). EImageBW16
BW32 Mono32 32-bit grayscale image (each pixel is stored in 4 bytes). EImageBW32

C15 RGB5 15-bit color image (each pixel is stored in 2 bytes).
Compatible with Microsoft® Windows RGB15 color images. EImageC15

C16 RGB565 16-bit color image (each pixel is stored in 2 bytes).
Compatible with Microsoft® Windows RGB16 color images. EImageC16

C24 RGB8 24-bit color image (each pixel is stored in 3 bytes).
Compatible with Microsoft® Windows RGB24 color images. EImageC24

C24A BGRa8 32-bit color image (each pixel is stored in 4 bytes).
Compatible with Microsoft® Windows RGB32 color images. EImageC24A

TIP
Easy.GetBestMatchingImageType returns the best matching image type for a
given file on disk.
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Depth Maps

Open
eVision

Genicam
PNFC Definition Class

EDepth8 Coord3D_C8 8-bit depth map
(each pixel is stored in 1 byte as an integer) EDepthMap8

EDepth16 Coord3D_C16 16-bit depth map
(each pixel is stored in 2 bytes as a fixed point) EDepthMap16

EDepth32f Coord3D_C32 32-bit depth map
(each pixel is stored in 4 bytes as a float) EDepthMap32f

TIP
8 and 16-bit depth map values are stored in buffers compatible with the 2D
Open eVision images.

Point Clouds

Open
eVision Genicam PNFC Definition Class

Point Cloud Coord3D_ABC32 Set of points coordinates
(each coordinate is stored in 4 bytes as a float) EPointCloud

3.3. Supported Image File Types

2 For the enumeration of the available types, see "EImageFileType Enum" on page 1.

Type Description
BMP Uncompressed image data format (Windows Bitmap Format).

JPEG A lossy data compression standard issued by the Joint Photographic Expert Group
registered as ISO/IEC 10918-1. The compression irretrievably loses quality.

JFIF JPEG File Interchange Format.

JPEG-2000

A data compression standard issued by the Joint Photographic Expert Group registered as
ISO/IEC 15444-1 and ISO/IEC 15444-2.
Open eVision supports only lossy compression format, file format and code stream variants.
- The code stream describes the image samples.
- The file format includes meta-information such as the image resolution and color space.

PNG Lossless data compression method (Portable Network Graphics).

Serialized The Euresys proprietary image file format obtained from the serialization of Open eVision
image objects.

TIFF

The Tag Image File Format is currently controlled by Adobe Systems and uses the LibTIFF
third-party library to process images written for the 5.0 or 6.0 TIFF specification.
- The file save operations are lossless and save the images without any compression.
- The file load operations support all the TIFF variants listed in the LibTIFF specification.

3.4. Color Types

Open eVision supports the following color systems:
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EISH Intensity, Saturation, Hue
ELAB CIE Lightness, a*, b*
ELCH Lightness, Chroma, Hue
ELSH Lightness, Saturation, Hue
ELUV CIE Lightness, u*, v*
ERGB NTSC/PAL/SMPTE Red, Green, Blue
EVSH Value, Saturation, Hue
EXYZ CIE XYZ
EYIQ CCIR Luma, Inphase, Quadrature
EYSH CCIR Luma, Saturation, Hue
EYUV CCIR Luma, U Chroma, V Chroma

3.5. Pixel and File Types Compatibility

For the compatible combinations in the following table, the image integrity is preserved with no
data loss (except from JPEG and JPEG2000 with lossy compression).

The other combinations are not supported and an exception occurs if you use them.

Type BMP JPEG JPEG2000 PNG TIFF Serialized

BW1 ✓ – – ✓ ✓ ✓

BW8 ✓ ✓ ✓ ✓ ✓ ✓

BW16 – – ✓ ✓ ✓ 2 ✓

BW32 – – – – ✓ 2 ✓

C15 ✓ ✓ 1 ✓ 1 ✓ 1 ✓ 1 ✓

C16 ✓ ✓ 1 ✓ 1 ✓ 1 ✓ 1 ✓

C24 ✓ ✓ ✓ ✓ ✓ 1 ✓

C24A ✓ – – ✓ – ✓

Depth8 ✓ ✓ ✓ ✓ ✓ ✓

Depth16 – – ✓ ✓ ✓ 2 ✓

Depth32f – – – – – ✓

● ✓ 1 : C15 and C16 formats are automatically converted into C24 during the save operation.

● ✓ 2 : BW16 and BW32 are not supported by Baseline TIFF readers.
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1. Selecting your Programming
Language

When you start Open eVision Studio for the first time, the following welcome screen is
displayed:

1. Select your programming language.

TIP
Your selection is saved and your programming language will be
automatically selected next time you start Open eVision Studio.

NOTE
When you change your programming language, any script present in the
scripting window is automatically deleted and the window content is reset.

2. Click on one of the Load buttons to already load one or several images for later processing.

3. Check the Do not show at startup box to hide this welcome screen next time you start Open
eVision Studio.

TIP
To access this welcome screen at any time, and change this setting, go to
the Help > Welcome Screen menu.

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation
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2. Navigating the Interface

Open eVision Studio graphical user interface (GUI) is organized as follows:

1. The main menu bar gives you access to the functions and tools of all libraries.

TIP
Open eVision Studio does not require any license and allows you to test all
libraries. Of course, if you copy code from Open eVision Studio in your own
application but you do not have the required license, you will receive a
"missing license" error at run-time.

2. The main toolbar gives you quick access to main Open eVision objects such as images,
shapes, gauges, bar codes, matrix codes...

3. The script window displays the code, in the programming language you selected,
corresponding to the actions you perform in Open eVision Studio. You can save or copy this
code in your own application at any time.

4. The image windows display the open images that you can process using the libraries and
tools.

5. The tool windows enable you to easily configure all the available tools. The corresponding
settings are automatically added in the script window for easy reuse.

TIP
Most tool windows are floating and you can easily move them outside the
Open eVision Studio main window to make better use of your screen size.

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation
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6. The execution time bar displays the precise time taken for the execution of the selected
functions (measured in milliseconds or microseconds) on your computer. This accurate
measurement helps you to evaluate the performance of your application.

7. The color toolbar displays current information such as the X and Y coordinates of the cursor
on an image and the corresponding pixel value.

8. The status bar displays general information about the application such as the active image
file path...

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation
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3. Running Tools on Images

3.1. Step 1: Selecting a Tool

When you use Open eVision Studio, the first step is to select the library and the tool you want to
use on your image.

To do so:

1. In the main menu bar, click on the library you want to use.

2. Click on the tool you want to use.

TIP
All libraries (except EasyImage, EasyColor and EasyGauge) expose only one
tool named New Xxx Tool. Some of these libraries also expose additional
functions.

3. In the dialog box, enter a Variable name for the variable that is automatically created and
that will contain the result of the processing.

Example of variable creation dialog box for EasyQRCode

4. Click OK.

The selected tool dialog box opens.

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation
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Example of variable creation dialog box for EasyQRCode

The next step is "Step 2: Opening an Image" on page 22.

3.2. Step 2: Opening an Image

Once you have selected your library and your tool, you need to open an image to apply this
tool.

In the Source Image area of the selected tool dialog box:

1. Open an image:

□ Click on the Open an Image button and select one or several (using SHIFT and CTRL)
images on your computer.

□ Or select one of the images (or one of the ROIs, if any) already open in the drop-down list.

NOTE
You can select only images with an appropriate file format (JPG, PNG, TIFF
or BMP) and in 8- and/or 24-bit depending on the library.

2. If you selected several images, activate one with the  Load Previous or  Load Next
buttons.

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation
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The tool is automatically applied on any loaded image and, at this stage, the result is displayed
based on the tool default settings.

The next step is "Step 3: Managing ROIs" on page 23.

3.3. Step 3: Managing ROIs

In some cases, most often to decrease the processing time or to single-out the object you want
to read, you do not want to process the whole image but only one or several well defined
rectangular parts of this image, or ROIs (Regions Of Interest).

TIP
In Open eVision, ROIs are attached to an image and exist only as long as the
parent image is available.

Creating a ROI

1. Open the image:
□ If the image is already open, activate the corresponding image window.
□ If the image is not open yet, go to the main menu: Image > Open... to open one.

2. To create an ROI, go to the main menu: Image > ROI Management....

The ROI Management window is displayed as illustrated below.

3. Select the image in the tree.

4. Click on the New button.

5. In the dialog box, enter a Variable name for the new ROI.

The ROI is represented as a color rectangle on your image as illustrated below.

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation
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6. Drag the ROI corner and side handles to move it to the required position.

7. Click on the Close button to close the ROI Management window .

The next step is "Step 4: Configuring the Tool" on page 25.

Managing ROIs

You can add, change and remove ROIs.

TIP
An image can have several ROIs. Each ROI can be attached directly to the
image (meaning that its position is relative to the image) or to another ROI
(meaning that its position is relative to this 'parent' ROI).

1. To manage ROIs, go to the main menu: Image > ROI Management....

The ROI Management window is displayed with the ROI relation tree as illustrated below.

If the Draw Rois box is checked, all ROIs are displayed on the image with a different color.

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation
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2. Select an ROI in the ROI relation tree.

3. Drag the ROI corner and side handles to change the position and size of the selected ROI (as
well as the position of all ROIs attached to it if any).

4. Click on the New button to add a new ROI attached to the selected ROI.

TIP
Select the image at the top of the ROI relation tree to attach the ROI directly
to the image.

5. Click on the Remove button to delete the selected ROI (and all ROIs attached to it if any).

6. Click on the Close button to close the ROI Management window.

3.4. Step 4: Configuring the Tool

Once your image, including its ROIs if you created some, is ready, you need to configure your
tool.

In the tool window:

1. Open the various tabs.

TIP
When you create a new tool, all parameters are set with their default value.

Open eVision Getting Started PART II Open eVision Studio for
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Example of the parameter tab of an EasyQRCode tool

2. In each tab, set the value of the parameters as desired.

Please refer to the "Functional Guide" and to the "Reference Manual" for detailed information
about the parameters, their function and their default value.

For specific actions such as learning or using gauges, please refer to the "Functional Guide".

3. Run the tool and analyze the results as described in the next step "Step 5: Running the Tool
and Checking Execution Time" on page 26.

3.5. Step 5: Running the Tool and Checking
Execution Time

Once your tool parameters are set, run your tool and, if desired, check the execution time on
your computer.

In the tool window:

1. Click on the Read, Detect, Results or Execute button (depending on the library function), to
run the tool on the selected image.

2. Check the results on the image and in the Results field or area as illustrated below.

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation
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Example of results after reading a QRCode

3. If you do not have the expected results:
□ Try to change your parameters (start with default values then change one parameter at a

time).
□ If your image is not good enough, try to enhance it as described in .

4. Check the execution time in the execution time bar at the bottom left of the main Open
eVision Studio window.

The execution time

TIP
The execution time is the actual time that the processing took as measured
on your computer. It depends your computer processor, memory, operating
system... and, of course, on the processor load at the time of execution. Thus
this execution time slightly varies from execution to execution.

5. To get a more representative execution time, click on the Read, Detect, Results or Execute
button several times and calculate the mean execution time.

6. If your application requires that you reduce the execution time, try:
□ To change the tool parameters,
□ To add one or several ROIs on your image,
□ To enhance your image.

The next step is "Step 6: Using the Generated Code" on page 28.

Open eVision Getting Started PART II Open eVision Studio for
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3.6. Step 6: Using the Generated Code

By default, Open eVision Studio translates all the operations you perform in the interface into
code in the language you selected as illustrated below.

Once your tool results suit you, you can save or copy this generated code to use it in your own
application.

Copy and paste the code in your application

In the script window:

1. Select the code section you want to copy.

2. Right click on this code and click Copy in the menu.

3. Go to your development environment tool and paste the code in place.

Save the code

1. Go to the Script menu.

2. Click on Save Script As....

3. Enter a file name and path to save the code as a text file.

Manage the generated code

In the Script menu, you can:
□ Select the programming language (please note that if you change the language, the script

window content is automatically deleted).
□ Activate or deactivate the Script Code Generation. Deactivate this option if you want to

perform some operations without saving them as code.

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation
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4. Pre-Processing and Saving Images

When should you pre-process your images?

Of course, the best situation is to set up your image acquisition system to have good and easy
to process images so the Open eVision tools run smoothly and efficiently.

If this is not possible or easy to achieve, you can pre-process your images or your ROIs to
enhance and prepare them for the Open eVision tool you want to run.

Using the various available functions, you can adjust the gain and offset of your image, apply a
convolution, threshold, scale, rotate and white balance your image, enhance contours... using
EasyImage and EasyColor functions.

Pre-processing images

The difference between pre-processing an image and running tools is that the pre-processing
generates a new image while the tools mainly extract and retrieve information from the image
without changing it.

To pre-process an image or an ROI:

1. In the main menu bar, click on the library you want to use (EasyImage or EasyColor).

2. Click on the function you want to use.

Most function dialog boxes are similar to the one illustrated below with 2 image selection areas
and a parameter setting area.

Example of a pre-processing dialog box (Threshold with EasyImage)

3. If there are multiple versions for your selected function, open the corresponding tab.

4. In the Source Image area, open the source image (as described in "Step 2: Opening an
Image" on page 22).

5. In the Destination Image area, open or create a new destination image.

6. Set your parameters.

7. Click on the Execute button.

The pre-processed image is available in the destination image as illustrated below.

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation
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Source and destinations images (Threshold with EasyImage)

8. If you want to use the destination image outside of Open eVision Studio, save it as described
below.

Saving an image

1. Click on the image you want to save to makes its window active.

2. To open the save menu either:
□ Right-click in the image
□ Or open the main menu > Image

3. Click on Save as....

4. Select the file format (JPEG, JPEG2000, PNG, TIFF or Bitmap).

5. Enter a name and select a path.

6. Click on the Save button.

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation
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1. Start the Application and Open a
Project

1. Launch Easy3D Studio.

The following screen is displayed:

2. Select your stream in the list of the available streams displayed in the Select Stream area.

3. Open your project (.json file):
□ Click on Create Project to create a new project.
□ Click on Load Project to open an existing project.

Open eVision Getting Started PART III Easy 3D Studio for 3D
Evaluation
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The main screen is displayed as illustrated:

Open eVision Getting Started PART III Easy 3D Studio for 3D
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2. Configure the Acquisition ROI

1. Open the Profile tab.

2. Click on the  run button to start free-running acquisition.
3. Place your caliber or your object under the laser line.

TIP
To optimize the computation time, make sure the laser line illuminates the
lowest as well as the highest areas of the object.

Open eVision Getting Started PART III Easy 3D Studio for 3D
Evaluation
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4. In the Profile window, move and resize the ROI (the green rectangle) to fit and enclose the
laser line image.

TIP
With a smaller the ROI, the extraction computation is faster and the
resolution is better.

5. In the parameter list, select the ExtractionMethod to use to compute the laser line extraction.

TIP
Do not use MaxDetection_8 if your ROI height is larger than 256 as this would
introduce a saturation effect in the extraction result.

6. Once the setup is complete, click on the  pause button to stop the acquisition.

Open eVision Getting Started PART III Easy 3D Studio for 3D
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3. Calibrate the Setup

1. Open the DepthMap tab.

2. Place your caliber on your system.

3. Click on the  run button to start an acquisition.
4. Move the caliber under the camera and wait for the image acquisition to complete.

5. Once the acquisition is displayed, click on the  pause button to stop the acquisition.

Open eVision Getting Started PART III Easy 3D Studio for 3D
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6. Open the PointCloud tab.

7. Use the mouse on the image to freely move it around in 3D.

Open eVision Getting Started PART III Easy 3D Studio for 3D
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8. In the parameter list:
□ Set CalibrationMethod to ObjectBasedMethod.
□ Select the Objecttype corresponding to your caliber.

9. Click on the Calibrate button.

After some processing, the calibrated image point cloud is displayed.

Open eVision Getting Started PART III Easy 3D Studio for 3D
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4. Acquire a Depth Map

1. Open the DepthMap tab.

2. Place your object on your system.

3. Click on the  run button to start an acquisition.
4. Move the object under the camera and wait for the image acquisition to complete.

5. Once the acquisition is displayed, click on the  pause button to stop the acquisition.
The "raw" image of your object is displayed.

Open eVision Getting Started PART III Easy 3D Studio for 3D
Evaluation



40

6. Open the PointCloud tab.

The calibration correction is applied to the image before display.

7. Use the mouse on the image to freely move it around in 3D.

Open eVision Getting Started PART III Easy 3D Studio for 3D
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8. Open the ZMap tab.

The corresponding ZMap is generated and displayed.

9. Configure the ZMap view:
□ Select the projection axis of the image: set the ReferencePlaneMode as X, Y or Z-plane.
□ Along the selected axis, set the offset of the displayed image.

10.Click on the Compute button to apply your changes and display the new image.

Open eVision Getting Started PART III Easy 3D Studio for 3D
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5. Export a ZMap

1. Open the File menu.

2. Click on Export ZMap.

3. Select the type of file you want to create:
□ PNG
□ TIFF
□ BMP (Bitmap)

4. Enter the file name.

5. Click on the Save button.

You can also save a profile, a depth map or a point cloud the same way.

The available file formats are:
□ Profile: PNG, TIFF, Bitmap
□ Depth map: PNG, TIFF, Bitmap
□ Point cloud: PCD

Open eVision Getting Started PART III Easy 3D Studio for 3D
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6. Add or Remove Parameters

The parameters listed in the different tabs are the basic software parameters that you need to
control and adjust to use Easy3D Studio.

In the Profile and in the DepthMap tabs, you can add some hardware parameters (related to the
frame grabber or to the camera) that you want to quickly and easily display or control:

1. Open the GenICam menu.

2. Click on GenICam.

The GenICam window opens as illustrated.

3. To show or hide a parameter, click on the 'eye' icon:
□ Left : the parameter is hidden in the Profile tab.
□ Right : the parameter is hidden in the DepthMap tab.
□ Left : the parameter is displayed in the Profile tab.
□ Right : the parameter is displayed in the Profile tab.

TIP
The changes are automatically and immediately applied in the Easy3D
Studio main window.

4. Close the GenICam window .

5. To save your changes, open the File menu and click Save Project.

Open eVision Getting Started PART III Easy 3D Studio for 3D
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1. What is the Neo Licensing System?

What is the Neo Licensing System?

● Neo is the name of the new licensing system of Euresys. It will progressively protect the
software products from Euresys.

● The Neo Licensing System is used for Open eVision, where it is supported in addition to the
already existing licensing systems. In the future, il will also protect some features in the
eGrabber software tool and other products.

Why the Neo Licensing System?

● The Neo Licensing System brings reliable, up-to-date IP protection to Euresys products as
well as more flexibility for the users.

● In the future, it will also enable useful licensing options such as network licenses
compatibility.

How does the Neo Licensing System work?

To use a product protected by the Neo Licensing System:

1. Buy the corresponding license from Euresys or one of its distributors.

2. You receive a Ticket ID corresponding to that license.
□ This Ticket ID is used to get the license.
□ This Ticket ID is necessary to communicate with your seller in case of an issue.
□ So, keep it safe and archived for any future use.

3. Use the Ticket ID to activate the license on your computer.

You can activate your license either directly on the computer, as a software license, or on a
Neo USB Dongle, that you can buy from Euresys.
□ Until you decide on which container (computer or dongle) you want to put your license,

this license is not linked to anything.

TIP
You can activate a Neo License directly on a computer. Nevertheless, we
recommended to use a Neo USB Dongle to have a more secure and an easily
portable license storage solution.

4. Use your Euresys product.

The Neo License Manager tool

● A new license management tool, the Neo License Manager, is available to activate, check
and debug problems that might arise with Neo Licenses.

It comes in 2 versions:
□ As an application with a user interface, complete and easy-to-use.
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□ As a command-line utility to automate your processes such as the product installations.
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2. Selecting the Licensing Model

Starting with Open eVision 2.13, you can select the Open eVision licensing model(s) that you
use with your application.

TIP
This avoids the delays that are sometimes added by the initialization of
licensing models you do not use.

The SelectLicensingModel function

● To select the licensing models to enable with Open eVision, call the following function:
Preconfiguration::SelectLicensingModels(ELicensingModel model)

● Always call it before any other Open eVision function as calling it after the first call to Open
eVision has no effect.

● The SelectLicensingModels function takes a single argument:
□ The licensing models to enable, as described by the ELicensingModel enumeration.

The ELicensingModel enumeration

● The ELicensingModel enumeration contains the different licensing models you can enable
within Open eVision:
□ Neo: the new licensing model introduced with Open eVision 2.13.
□ LegacyDongle: the licensing model associated to the dongles used before 2.13.
□ All (default): this licensing model enables all the others (Neo + LegacyDongle).
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3. Using the User Interface

The Neo License Manager user interface

The Neo License Manager is organized in 6 areas:

1. A list of the license containers and the licenses they contain.

2. The interface language configuration.

3. The online Neo License activation.

4. The offline Neo License activation.

5. The creation of a software container (this area is hidden after creating a software container).

6. The troubleshooting.

Activate an online license

1. Click on the Activate a license button to open the License activation dialog.
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2. Enter the required information:
□ The container on which you want to activate the license.
□ The Ticket ID (5 groups of 5 alphanumeric characters separated by a dash).

NOTE: If there is no software license container yet, create one from the main window before
opening the license activation dialog.

System reinstallation

If you have to reinstall the system and lost your licenses:

1. Activate the license with the old Ticket ID to try to recover all the licenses associated to the
container where you first activated this Ticket ID.

This only works if:
□ It is done in a new, empty container.
□ The system is recognizable (the hardware is more or less the same).

2. If this does not work or if you lost your licenses and the system has changed significantly (for
instance after the failure and replacement of a hardware component), you need to request a
reactivation:
□ Contact the support to obtain a reactivation authorization for the corresponding Ticket

ID.
□ Once the reactivation is authorized, perform the license activation procedure as usual.
□ The Neo License Manager asks for the confirmation of the reactivation.

NOTE
The reactivation disables the previous activation on the other system.
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Activate an offline license

The offline license activation allows you to activate licenses on a machine A that is not
connected to the Internet through a machine B that is connected to the Internet.

The offline license activation is a 3 steps procedure:

1. On machine A:

a. Click on the Get fingerprint file button to open the Get a fingerprint file dialog.

b. Enter the required information:
□ The license container on which you want to activate the license.
□ The path to save the fingerprint file.

2. On machine B:

a. Click on the Online request of license file for offline activation button to request
the corresponding license file.

b. Enter the required information:
□ The Fingerprint file from machine A.
□ The License file output path to save the license file.
□ The Ticket ID (5 groups of 5 alphanumeric characters separated by a dash) for the license.

3. On machine A:

a. Click on the Apply license file button.

b. Select the license file generated in step 2.
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Creating a software container

To activate a license on a software container:

1. Click on the Create software container button (area 5 in the main window) to create a new
software container.

2. Click on the Yes button to confirm the creation of the software container.

3. The software container is now available in the license activation dialogs and in the main
license list (area 1 in the main window).
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Preparing a dongle to use the OEM key functionality

● You can use the Neo USB Dongles with the OEM Key functionality provided by
Easy::SetOEMKey and Easy::CheckOEMKey.

● When a preparation is required, a warning text appears in the list of the dongle licenses.

● Click on that text and follow the instructions.
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Troubleshooting

1. Click on the Emergency activation and report button to open the Troubleshooting dialog.

2. Click on the Apply emergency license button to temporarily activate licenses:
□ These licenses activate all Euresys products.
□ They are valid for 8 days.
□ You can repeat this a maximum of 3 times.
□ For security reasons, you cannot activate emergency licenses on virtual machines.

3. Click on the Save report to file button to generate a licensing system report and save it to
a file.
□ The support team may require this report when you have a licensing issue.

4. Click on the Save log to file button to generate a licensing system log and save it to a file.
□ The support team may require this log when you have a licensing issue.
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4. Using the Online Command Line

● When you order a Neo License, Euresys sends you a Ticket ID required to activate the license
on your system.
□ A Ticket ID is made of 5 groups of 5 alphanumeric characters separated by a dash.

For example: TT5YY-HYAGN-Q2PBU-U7K7J-DKJJQ
□ You can activate your license either directly on the computer, as a software license, or on

a Neo USB Dongle, that you can buy from Euresys.

● In the case of the software container, the license is strongly linked to a single computer
system, while with a dongle you can move it easily from computer to computer.

Select a container

1. To select a license container, use the ListContainers command of the Neo License Manager.

All the containers compatible with Euresys licenses are listed:

> NeoLicenseManagerCL.exe ListContainers
Container list:

130-3613949292 (software)

□ A software container appears in the list with a serial number starting with 130-.
□ A dongle appears in the list with a serial number starting with 3-. This serial number is

also written on the dongle itself.

2. To create a software container, use the CreateSoftwareContainer command of the Neo
License Manager.

> NeoLicenseManagerCL.exe CreateSoftwareContainer
Software container 130-3245488904 has been created.

If you already have a software container on your system:
□ We highly recommended you to use that one.
□ Create a new software container only if the old one is broken for any reason. The old

license container unavailable for activation purposes.

3. Copy the serial number of the container you want to use for the next step.
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Activate the license

1. To activate the license, use the ActivateLicense command of the Neo License Manager with
the serial number of the container.

> NeoLicenseManagerCL.exe Activate -t TT5YY-HYAGN-Q2PBU-U7K7J-DKJJQ -sn 130-3245488904
Activation of ticket TT5YY-HYAGN-Q2PBU-U7K7J-DKJJQ has been done succesfully.

The command associates the Ticket ID to the container and activates the license.

Check the Neo License presence

1. To check the presence of the license, use the ListLicenses command of the Neo License
Manager.

The new license appears under the serial number of the license container.

> NeoLicenseManagerCL.exe ListLicenses
Licenses on container 130-3613949292 (software):

Open eVision EasyOCR

Activating the OEM key feature

By default, the dongles come with the OEM key feature activated. Nevertheless, older dongles
may have to be activated.

● To check if this feature is activated use the CheckOEMKeyReadiness command:

> NeoLicenseManagerCL.exe CheckOEMKeyReadiness –sn 3-3613949292

● If the feature is not activated on the dongle, use the PrepareForOEMKey command to activate
it:

> NeoLicenseManagerCL.exe PrepareForOEMKey –sn 3-3613949292

Forcing more than one copy of the same license

● By default, the license manager protects you against multiple activations of the same license
in a container, refusing the subsequent activations:

● If you want to bypass that protection, use the –force flag:

> NeoLicenseManagerCL.exe Activate –force -t TT5YY-HYAGN-Q2PBU-U7K7J-DKJJQ -sn 130-3245488904
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Troubleshooting

Command line help

● To get help about the syntax and the usage of the command line, use the Help command:

> NeoLicenseManagerCL.exe Help

Here are the available commands and their arguments:

ListContainers [-filter (dongle|software)]
Print the list of the containers currently available.

ListLicenses [-sn SERIAL]
Print the list of the licenses currently available.

ApplyLicense -path PATH
Apply the given activation file to the software container of your computer.

CreateSoftwareContainer
Create a new software container on the computer. It will only work if none were present.

GetFingerprint -sn SERIAL -path PATH
Save the fingerprint file of the given container at the specified location.

CheckOEMKeyReadiness -sn SERIAL
Check if the OEM key feature is available in the given container.

PrepareForOEMKey -sn SERIAL
Activate the OEM key feature on the given container.

CheckStatus
Do a global check-up of the neo licensing system and print it.

Report -path PATH
Save the output of the CheckStatus command to the specified location.

DumpLog
Print the contents of the log file.

Activate -t NEO_TICKET_ID -sn SERIAL
Activate a neo ticket ID on the given container.

Reactivate -t NEO_TICKET_ID -sn SERIAL
Reactivate a neo ticket ID on the given container.

RequestActivationFile -fingerprintPath PATH -outPath PATH -t NEO_TICKET_ID
Generate an activation file using the given neo ticket ID and container fingerprint file. This file can then be
used to proceed to an offline activation.

RequestReactivationFile -fingerprintPath PATH -outPath PATH -t NEO_TICKET_ID
Generate an reactivation file using the given neo ticket ID and container fingerprint file. This file can then
be used to proceed to an offline reactivation.

RequestEmergencyActivation
Activate one of the three emergency licenses packages. It has a 8 days duration.
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Emergency licenses

If you need a license for a limited time (for instance while waiting for some support), use an
emergency license.

1. To activate an emergency license , use the RequestEmergencyActivation command:
□ These licenses activate all Euresys products.
□ They are valid for 8 days.
□ You can repeat this a maximum of 3 times.
□ For security reasons, you cannot activate emergency licenses on virtual machines.

> NeoLicenseManagerCL.exe RequestEmergencyActivation

License recovery with a software container

If you have to reinstall the system and lost your licenses:

1. Create a software container.

2. Activate the license with the old Ticket ID to try to recover all the licenses associated to the
container where you first activated this Ticket ID.

This only works if:
□ It is done in a new, empty container.
□ The system is recognizable (the hardware is more or less the same).

3. If this does not work, perform a reactivation.

Reactivation

If the recovery does not work or if you lost your licenses and the system has changed
significantly (for instance after the failure and replacement of a hardware component), you
need to perform a reactivation.

□ This transfers your lost license on a container on the new system.
□ By default, the reactivation is disabled.

1. Contact the support to obtain a reactivation authorization for the corresponding Ticket ID.

2. Once the reactivation is authorized, follow the license activation procedure described above
but use the Reactivate command instead of Activate.

Error reporting

If anything fails, the Neo License Manager returns an error and information about it in stderr.

1. To recover the stderr log in the command line, you can use 2> redirection, as follows:

NeoLicenseManagerCL.exe Activate -t TT5YY-HYAGN-Q2PBU-U7K7J-DKJJQ -sn 130-3245488904 2>c:\tmp\error.log

2. If you need more information, use the Memento tool from Euresys.
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3. To check the status of the licensing system on your computer at any time, use the
CheckStatus command of the Neo License Manager.

> NeoLicenseManagerCL.exe CheckStatus
** Starting List Product Item for box 130-3613949292 and firm code 6001261 **
Found Productcode (Dependency: 0x7): 4305
Text (#=20, Dependency 0x00): "Open eVision EasyOCR"
Extended Protected Data (#=16, Type 136, Dependency 0x07): 6c 63 64 63 00 01

9b 05 00 00 00 00 00 00 01 00
** List Product Item finished without errors **

4. To check the log of the licensing system on your computer at any time, use the DumpLog
command of the Neo License Manager.

> NeoLicenseManagerCL.exe DumpLog
** L.M version 23.08.0 09/07/23 14:25:02 : Emergency activation was requested.
L.M version 23.08.0 09/07/23 14:25:03 : Emergency activation was successful. There is (are) 2 emergency license
(s) remaining. **
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5. Using the Offline Command Line

● When you order a Neo License, Euresys sends you a Ticket ID required to activate the license
on your system.
□ A Ticket ID is made of 5 groups of 5 alphanumeric characters separated by a dash.

For example: TT5YY-HYAGN-Q2PBU-U7K7J-DKJJQ
□ You can activate your license either directly on the computer, as a software license, or on

a Neo USB Dongle, that you can buy from Euresys.

● In the case of the software container, the license is strongly linked to a single computer
system, while with a dongle you can move it easily from computer to computer.

When to use the offline activation

Use the offline activation when the system on which you want to activate the license is not
connected to the Internet. Nevertheless, to activate the license, you must have access to
another computer that is connected to the Internet.

□ The system that needs a license and is not connected is called the target system.
□ The connected system is the online system.
□ Both systems need to have the Neo License Manager installed.

TIP
Neo USB Dongle activation
This procedure works for activating both dongles and software containers.
However, it is much easier to connect a dongle directly to the online system
and use the online procedure.

Select a container

1. To select a license container, use the ListContainers command of the Neo License Manager.

All the containers compatible with Euresys licenses are listed:

> NeoLicenseManagerCL.exe ListContainers
Container list:

130-3613949292 (software)

□ A software container appears in the list with a serial number starting with 130-.
□ A dongle appears in the list with a serial number starting with 3-. This serial number is

also written on the dongle itself.
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2. To create a software container, use the CreateSoftwareContainer command of the Neo
License Manager.

> NeoLicenseManagerCL.exe CreateSoftwareContainer
Software container 130-3245488904 has been created.

If you already have a software container on your system:
□ We highly recommended you to use that one.
□ Create a new software container only if the old one is broken for any reason. The old

license container unavailable for activation purposes.

3. Copy the serial number of the container you want to use for the next step.

Activate a license

The offline license activation is a 3 steps procedure:

1. On the target system, retrieve the fingerprint:

a. To retrieve the identification information, also called the fingerprint, use the
GetFingerprint command of the Neo License Manager.

> NeoLicenseManagerCL.exe GetFingerprint -sn 130-3245488904 -path "myfingerprintfile.fgp"

This command generates a fingerprint file.

b. Copy this file to the online system.

2. On the online system, request a license activation file:

a. To generate the license activation file, use the RequestLicenseFile command of the Neo
License Manager.

b. Use this command with the Ticket ID and the fingerprint file of the target system.

> NeoLicenseManagerCL.exe RequestActivationFile -fingerprintPath "myfingerprintfile.fgp" -t TT5YY-HYAGN-Q2PBU-
U7K7J-DKJJQ -outPath "mylicensefile.lif"

c. Copy this file to the target system.

3. On the target system, apply the license.

a. To activate the license in the chosen container use the ApplyLicense command of the Neo
License Manager.

b. Use this command with the license activation file.

> NeoLicenseManagerCL.exe ApplyLicense -path "mylicensefile.lif"

Check the Neo License presence

1. To check the presence of the license, use the ListLicenses command of the Neo License
Manager.

The new license appears under the serial number of the license container.

> NeoLicenseManagerCL.exe ListLicenses
Licenses on container 130-3613949292 (software):

Open eVision EasyOCR
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Troubleshooting

Command line help

● To get help about the syntax and the usage of the command line, use the Help command:

> NeoLicenseManagerCL.exe Help

Here are the available commands and their arguments:

ListContainers [-filter (dongle|software)]
Print the list of the containers currently available.

ListLicenses [-sn SERIAL]
Print the list of the licenses currently available.

ApplyLicense -path PATH
Apply the given activation file to the software container of your computer.

CreateSoftwareContainer
Create a new software container on the computer. It will only work if none were present.

GetFingerprint -sn SERIAL -path PATH
Save the fingerprint file of the given container at the specified location.

CheckOEMKeyReadiness -sn SERIAL
Check if the OEM key feature is available in the given container.

PrepareForOEMKey -sn SERIAL
Activate the OEM key feature on the given container.

CheckStatus
Do a global check-up of the neo licensing system and print it.

Report -path PATH
Save the output of the CheckStatus command to the specified location.

DumpLog
Print the contents of the log file.

Activate -t NEO_TICKET_ID -sn SERIAL
Activate a neo ticket ID on the given container.

Reactivate -t NEO_TICKET_ID -sn SERIAL
Reactivate a neo ticket ID on the given container.

RequestActivationFile -fingerprintPath PATH -outPath PATH -t NEO_TICKET_ID
Generate an activation file using the given neo ticket ID and container fingerprint file. This file can then be
used to proceed to an offline activation.

RequestReactivationFile -fingerprintPath PATH -outPath PATH -t NEO_TICKET_ID
Generate an reactivation file using the given neo ticket ID and container fingerprint file. This file can then
be used to proceed to an offline reactivation.

RequestEmergencyActivation
Activate one of the three emergency licenses packages. It has a 8 days duration.
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Emergency licenses

If you need a license for a limited time (for instance while waiting for some support), use an
emergency license.

1. To activate an emergency license , use the RequestEmergencyActivation command:
□ These licenses activate all Euresys products.
□ They are valid for 8 days.
□ You can repeat this a maximum of 3 times.
□ For security reasons, you cannot activate emergency licenses on virtual machines.

> NeoLicenseManagerCL.exe RequestEmergencyActivation

License recovery with a software container

If you have to reinstall the system and lost your licenses:

1. Create a software container.

2. Activate the license with the old Ticket ID to try to recover all the licenses associated to the
container where you first activated this Ticket ID.

This only works if:
□ It is done in a new, empty container.
□ The system is recognizable (the hardware is more or less the same).

3. If this does not work, perform a reactivation.

Reactivation

If the recovery does not work or if you lost your licenses and the system has changed
significantly (for instance after the failure and replacement of a hardware component), you
need to perform a reactivation.

□ This transfers your lost license on a container on the new system.
□ By default, the reactivation is disabled.

1. Contact the support to obtain a reactivation authorization for the corresponding Ticket ID.

2. Once the reactivation is authorized, follow the license activation procedure described above
but use the Reactivate command instead of Activate.

Error reporting

If anything fails, the Neo License Manager returns an error and information about it in stderr.

1. To recover the stderr log in the command line, you can use 2> redirection, as follows:

NeoLicenseManagerCL.exe Activate -t TT5YY-HYAGN-Q2PBU-U7K7J-DKJJQ -sn 130-3245488904 2>c:\tmp\error.log

2. If you need more information, use the Memento tool from Euresys.
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3. To check the status of the licensing system on your computer at any time, use the
CheckStatus command of the Neo License Manager.

> NeoLicenseManagerCL.exe CheckStatus
** Starting List Product Item for box 130-3613949292 and firm code 6001261 **
Found Productcode (Dependency: 0x7): 4305
Text (#=20, Dependency 0x00): "Open eVision EasyOCR"
Extended Protected Data (#=16, Type 136, Dependency 0x07): 6c 63 64 63 00 01

9b 05 00 00 00 00 00 00 01 00
** List Product Item finished without errors **

4. To check the log of the licensing system on your computer at any time, use the DumpLog
command of the Neo License Manager.

> NeoLicenseManagerCL.exe DumpLog
** L.M version 23.08.0 09/07/23 14:25:02 : Emergency activation was requested.
L.M version 23.08.0 09/07/23 14:25:03 : Emergency activation was successful. There is (are) 2 emergency license
(s) remaining. **
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6. Neo Licensing System FAQ

Why the new Neo Licensing System?

● The old (legacy) licensing system of Open eVision was introduced about 15 years ago. Since
then, licensing technologies have evolved significantly.

● We now introduce the Neo Licensing System to take advantage of this evolution and provide
numerous improvements in this release and in future versions of Open eVision.

How do I use a Neo License?

● After ordering a Neo License, you will receive a document (typically a shipping note)
containing a unique Ticket ID.

● With this Ticket ID, use the new Neo License Manager to activate your Neo License in the
container of your choice (a Neo USB Dongle (PC6514) or a Neo Software Container).

● Once the Neo License is activated, you are able to use Open eVision.

What should I do with my Ticket ID after activation?

● Very carefully store your Ticket IDs where you can retrieve them easily. In addition, we
recommend that you keep track of which Ticket ID is activated on each dongle, system or
machine.

● If you ever experience a licensing issue, this Ticket ID is required when you contact your
distributor or Euresys support.

On which device can I activate my Neo License?

● You can activate your Neo License either on a Neo USB Dongle (PC6514) or on the hard drive
of a compatible computer system via Neo Software Container.

Do I have to choose where I want to activate my Neo License when I order it?

● No, you just have to order a Neo License for the product you want to use.
□ Neo Licenses of Open eVision libraries have product codes starting with 43.
□ These licenses are valid for activation on a Neo USB Dongle (PC6514) or on a Neo

Software Container.

Can I use a Neo License with an older legacy Euresys dongle?

● No, Neo Licenses can only be activated on a Neo USB Dongle (PC6514).

● The old USB Dongle (PC6512) and the PAR Dongle (PC6513) cannot be used with Neo
Licenses.
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Can I use a Neo License with a dongle from another company?

● No, you can only activate a Neo License on the Neo USB Dongle (PC6514) purchased from
Euresys or from a Euresys distributor.

When should I use a Neo Software Container instead of a dongle?

● We recommend that you only use a Neo Software Container if your system cannot handle a
USB dongle.

● Neo Software Containers are locked to a computer system and computers are more fragile
than USB dongles. USB dongles can easily be moved to a replacement computer in case of a
failure of the computer or in case of an upgrade.

I have activated a Neo License on a Neo Software Container on my computer.
Can I move it to a new computer?

● No, once you have activated a Neo License on a Neo Software Container on a computer, it is
locked to that computer and it cannot be moved to another computer or to a Neo USB
Dongle.

I have activated a Neo License on a Neo Software Container on my computer.
My computer no longer worked and had to be repaired. What can I do?

● If your computer has been repaired by replacing the defective parts, try to reactivate your
license(s) from the Neo License Manager using the same Ticket IDs as originally used on this
computer. If your computer is still recognized by the Neo License Manager, the license(s) will
be restored.

● If this process fails, or if your computer cannot be repaired and you wish to use a new
computer, please contact your distributor or Euresys support to request the reactivation of
the license(s). You will have to provide the original Ticket IDs used for that computer. When
that reactivation is granted, you can activate the corresponding license(s) again on a new
Neo Software Container.

Where can I find the new Neo License Manager?

● The Neo License Manager application is available both as a stand-alone installer and within
the Open eVision installation package (starting with release 2.13).

Can I use the Neo License Manager via command line?

● Yes, the Neo License Manager is available both as a Graphical User Interface application and
as a command line executable.

● The command line executable is less user friendly, but allows to automate the management
of Neo Licenses.

Can I use a legacy activation key with the Neo Licensing System?

● No, legacy activation keys only work with the legacy licensing system.

● The legacy licensing system, both dongles and software, however will still be supported for
the foreseeable future.
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Can the new Neo License Manager activate legacy licenses?

● No, the Neo License Manager application only manages Neo Licenses.

● The previous (legacy) License Manager, however, remains available in the Open eVision
package to manage legacy licenses.

I have (legacy) non-Neo USB Dongles or software licenses, can I still use them
with Open eVision 2.13 and higher?

● Yes, the licensing systems used before Open eVision 2.13 are still active and supported. They
will remain active and supported for the foreseeable future.

● However, for new projects, we highly recommend using the Neo Licensing System.

Can I restrict the choice of licensing system (Neo Licensing System or legacy) in
my application?

● Yes. A new Preconfiguration object is available in Open eVision (as of Open eVision 2.13) to
allow users to restrict the use to a particular licensing system.

● Note that using this feature is optional.

Are emergency licenses available with the Neo Licensing System? Are the
emergency licenses of the Neo Licensing System and the legacy licensing
system independent?

● Yes, emergency licenses are available with the Neo Licensing System, they are independent
of the legacy emergency licenses.

● Each of these licensing systems provides three time-limited emergency licenses.

Are all Open eVision libraries and bundles available with the new Neo Licensing
System?

● All current Open eVision libraries and bundles are available with the new Neo Licensing
System.

● However, some old legacy bundles may not be available with the new Neo Licensing System.
They remain available with the old licensing systems only.

What can I do if I have lost a Ticket ID?

● The Ticket ID is the unique identifier of a license. It is very important and must be securely
stored. If you ever experience a licensing issue, this Ticket ID is required when contacting
your distributor or Euresys support.

● Ticket IDs that have been activated on a Neo USB Dongle can be retrieved by Euresys
technical support from the dongle serial number.

● However, support for licenses stored in a Neo Software Container will not be possible if the
Ticket ID has been lost.
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Is an Internet connection required to activate a Neo License?

● Yes, an Internet connection is required to activate a Neo License on a Neo USB Dongle or on
a Neo Software Container.

● However, an Internet connection is not required to run Open eVision after the Neo License
has been activated.

Do I have to provide the serial number of a Neo USB Dongle when ordering a
Neo License?

● No, you do not have to provide the serial number of a Neo USB Dongle when ordering a Neo
License.

● You can activate a Neo License either on a Neo USB Dongle (PC6514) or on the hard drive of
a compatible computer system via a Neo Software Container.

● The link between the Neo License and the Neo USB Dongle is recorded during the activation.

Is it possible to add licenses for additional Open eVision libraries to Neo USB
Dongles that are already in the field?

● Yes. Just order the additional Neo Licenses and activate the new Ticket IDs on the existing
Neo USB Dongle as usual.

● The activation process is additive. It will add the new licenses to the licenses already
activated on the dongle. The existing licenses will not be lost.

● Please note that this operation requires an Internet connection.

Can I use a Neo License with older versions of Open eVision?

● No, the Neo Licensing System is only available as of Open eVision 2.13.

● However, the existing licensing systems remain available with the earlier releases of eVision
and Open eVision.

Is the 30-day evaluation license available with the Neo Licensing System?

● Yes. The Product Code is 4300.

● The time-limited 30-day evaluation license can be activated a single time either on a Neo
USB Dongle (PC6514) or on a Neo Software Container.

Why is my system start slower after installing the Neo Licensing System?

● Under Windows 7, there is a known issue concerning the Neo Licensing System where the
associated service can take a long time to start.

For more information on that issue and steps to solve it, please refer to the FAQ of the
service provider: https://www.wibu.com/support/faq/codemeter-miscellaneous.html

Open eVision Getting Started PART IV Neo Licensing System

https://www.wibu.com/support/faq/codemeter-miscellaneous.html

	PART I : Open eVision Basics
	1. Discovering Open eVision
	2. Using Vision in your Application
	3. Dealing with Pixel Containers and Files
	3.1. Pixel Container Definition
	3.2. Pixel Container Types
	3.3. Supported Image File Types
	3.4. Color Types
	3.5. Pixel and File Types Compatibility


	PART II : Open eVision Studio for Library Evaluation
	1. Selecting your Programming Language
	2. Navigating the Interface
	3. Running Tools on Images
	3.1. Step 1: Selecting a Tool
	3.2. Step 2: Opening an Image
	3.3. Step 3: Managing ROIs
	3.4. Step 4: Configuring the Tool
	3.5. Step 5: Running the Tool and Checking Execution Time
	3.6. Step 6: Using the Generated Code

	4. Pre-Processing and Saving Images

	PART III : Easy 3D Studio for 3D Evaluation
	1. Start the Application and Open a Project
	2. Configure the Acquisition ROI
	3. Calibrate the Setup
	4. Acquire a Depth Map
	5. Export a ZMap
	6. Add or Remove Parameters

	PART IV : Neo Licensing System
	1. What is the Neo Licensing System?
	2. Selecting the Licensing Model
	3. Using the User Interface
	4. Using the Online Command Line
	5. Using the Offline Command Line
	6. Neo Licensing System FAQ


